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What's New

Printable Tips of the Day

Thanks to a customer's request, we realized that it might be useful to have the tips shown in the tip-of-the-
day window available in printed form as a handy reference. However there's no easy way to print them all out
from the program.  Of course we encourage everyone to keep those tips enabled (and to actually take a few
seconds to read them instead of just closing the window) -- but we also know that most people don't do that.

Therefore we're adding a complete list of the tips to the documentation so it can be printed -- and if you get
the PDF version of this newsletter you can print out your own copy of the tips.  (If you're already reading the
PDF or electronic version, you'll see the tips at the end of this newsletter and can print them out from there.)
We encourage you to print them out and browse through them whenever you have a chance, and perhaps
mark the ones that you think you'll want to reference later.

Q & A

Adding notes to the Ticket Form receipt

Q: How do I add "Additional Notes" to the Ticket Forms, like I see when I print them from the demo?

A: These are set up in an unusual place, in part for backward compatibility with the original version and in
part because it allows some extra flexibility.

To add additional notes to the ticket form receipts, which will appear on the left side below the company
information, go to Maintenance / Park Setup / Parks.  There are 3 fields, Notes 1, Notes 2 and Notes 3.
Whatever you enter in those fields will appear as "Additional Notes".

Since this is in the Park record, you have the ability to show different notes for different parks (if you have
more than one Park set up).

For more information regarding the format of the notes (e.g. how to insert blank lines), see the Help -- press
F1 when you have the Park Setup window open, and scroll to the bottom for Notes help.
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Adding E-mail and phone information to receipts

Q: How can I show our E-mail address, web site, and additional phone numbers on our receipts?

A: Any of this information that you enter in the Park record fields will show on receipts (see Maintenance /
Park Setup / Parks).  it will also show the "Owner" field, which could be anything you want, for instance
"Managed by the Smiths".

Showing longer names on the Rack

Q: Some customer names don't fit on the Rack, so it just shows part of it with "..." at the end.  How
can I get them to fit?

A: You can make the Rack's grid cells larger -- Click the Options button at the top of the Rack, and enter a
larger number in the Cell Width field.  Of course the wider you make them, the fewer days you'll be able to
see at once.  Also note that the full name is shown as a pop-up tip when you put the mouse over a name, so
it's not necessary to make the cells large enough to show any possible name.

Allowing clerks to refund partial stays

Q: When there is a need to back out a charge from the Transaction screen, and I need to select the
rate and use a negative number in the "days" field to balance it out, it gives an error that I'm not
authorized to enter negative charges. It only does this for the "Reservation" level operator logins, not
the "Administrator".  Which access level setting needs to be adjusted to allow anyone to do this?

A: This is the access level "Enter negative amounts for charges or payments" (because the negative rate
days results in negative charges).  Go to Maintenance / Park Setup / Access Levels and look for that item.
Double-click on it and set the override level to "Reservations".

Tips & Techniques

Increasing rates for next year

(This article assumes that you have Rates set up for your rental charges rather than entering all charges
manually, and in particular applies if you use Auto-rates).

At some point you're probably going to want to increase your rates for the next year.  If you're already taking
reservations for next year then you want to make sure that quotes and confirmation letters show next year's
rates, not this year's.  But of course you can't just change the amounts in your Rates definitions because that
would charge the new rates to people staying this year also.

Basically what you need to do is enter all new rate definitions for next year's rates, while keeping this year's
rates in the system.  While this sounds like a tedious project, there are a couple tricks to doing it easily and
quickly.  Here is the process we recommend:

1. Go to Maintenance / Park Setup / Rates.
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2. Select ALL of the rates that need to be increased (Ctrl-click on each one, to select multiple rates).  You
don't need to select every rate, but you should copy all associated rates even if some of them won't change,
to avoid confusion (e.g. if only the daily rate is increasing, then copy the weekly and monthly rates also if
they would apply to the same sites).

3. Click "Copy Selected Rates".  This will create a copy of each rate and add it to the end of the rates list.

4. Select the first of the copied rates and "Edit rate definition" (or better yet, just double-click on the rate to
edit it).

5. Add something like "2006" to the Description so you know it's next year's rate.

6. Adjust the "Each" amount for the charges as needed.

7. Enter next year's season into "Season Dates Applicable" so that this rate only applies to reservations for
next year.  This should be entered in a form similar to "4/1/06 to 10/31/06".  (Canadian data formats may be
reversed like "1/4/06 to 31/10/06".)  Of course if you already have specific dates in this field, e.g. holiday
dates, these need to be altered appropriately.

8. (optional) Highlight the season date range entered and press Ctrl-C to copy the text, so you don't have to
type them over and over.

9. Click Save.

10. Repeat steps 4 through 9 for each of the other copied rates for next year.  You can use Ctrl-V to paste
the season dates into the other rates, if you copied them in step 8.

11. Now you need to move these new rates to the top of the list so they are checked *before* the default
(current) rates.  Select each of the copied/modified rates, and click "Move Up" until they're above the normal
rates.  Note: If you didn't copy and modify all rates, some inter-mingling may be required for it to work
properly.  Just keep in mind the ordering rules for auto-rates (see the documentation for details).

Now it should correctly use the new rates for next year's reservations.  Keep in mind that next year you will
need to either update the season dates (e.g. to extend the rates to 2007, 2008, etc) so they work for later
years, or else repeat the process for each year's rates increases.  We don't recommend deleting the old rates
later, because that could cause old reservations to re-calculate if you do any changes to them later,
especially long-term stays.  In fact, setting the Season Dates for old rates to be more specific might help
avoid problems of using the wrong rates.
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All Tips of the Day

You can open Help at any time with the F1 key.

Help information for the current function will be shown (depending on the screen you're on), which has the
same information as the complete software manual.

The entire manual is contained in the Help file.

Go to the Help menu and click 'Help Topics' to browse the manual's contents.

Advanced Tip: After opening the Help Contents, try the Index or Find tabs to locate a specific topic quickly.

The Quick-Start guide can be opened from the Help menu.

If you're just learning or if you need a quick refresher on some common functions, go to the Help menu to
open the Quick-Start guide.

Campground Master can import your existing customer or reservation lists.

If you have a customer list or reservation data from another program, you can import it into Campground
Master (see File / Import).

Note: The data needs to first be in "CSV" (comma separated values) or tab-delimited text format, which most
other software supports.

Tab views are dynamic reports.

Most of your daily reporting needs are covered by the "Tab views", which are actually reports that update
automatically.  These are accessed by clicking on the corresponding "Tabs" along the top (like folders in a
file cabinet), starting with "Rack".

Need to know who's arriving today?  Click "Arrivals".
Need to see who's in the park?  Click "On Site".

Advanced Tip: You can also use the Tab key on the keyboard to browse through the reports.

"Last Night" means exactly that -- the last night of their stay.

You might be used to citing the "check-out date", which is typically the following day (the next morning).  But
when specifying dates in Campground Master, you can't make it end the next day because it would prevent
another reservation starting the next afternoon.  Therefore the dates entered for a reservation, as well as the
dates on the Rack, correspond to "nights".  For instance, if a reservation is for one night, then it will occupy
one cell (block) on the Rack.

This may take some getting used to, but it will soon become natural.
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Double bookings are virtually impossible.

Campground Master checks for conflicting dates anytime you make a reservation or perform an action that
changes the dates, and will not allow double bookings.

Only certain administrative functions can bypass these checks, such as manually editing the raw data tables
(restricted to Administrators).

Advanced Tip: If you want to be sure everything is OK, use the Conflicting Reservations report under
Maintenance / Database Maintenance.

Campground Master can do automatic Zip Code lookup.

When entering customer information, just type the Zip Code (or Canadian Postal Code) in the City field, and
then press Tab.  If it's a recognized code, the city and state will be filled in automatically.

Advanced Tip:  There's no need to format the Zip or Postal Code perfectly -- for instance you can skip the
dash in 9-digit zip codes, or skip the space in Canadian Postal Codes.  It will format it correctly after the
lookup is done.

You can save your sample data changes to a different file.

If you're making changes to the sample database ("Demo") that you want to keep when you purchase the
program, use File / Save As.  Give it a name, and put it in a permanent location.  This is important to prevent
software upgrades from overwriting your data (the "Demo" database is usually overwritten when a software
update is done).

Note: Once you use a different name, it won't log you in automatically any more.  Be sure to set up your own
operator login through Maintenance / Park Setup / Operators (or you can continue to use the default
Administrator / Password login.)

Names and addresses can be automatically formatted.

If you prefer that names and address information be shown in mixed case, like "Smith" (with the first letter
capitalized), you can turn on auto-formatting so you don't have to hold the shift key down when typing.

See Maintenance / Program Options / Formats to enable auto-formatting of customer information.

Financial reports are in the Transactions tab view, not in the menus.

Click the "Summary Options" button on the Transactions tab and you'll see a number of Quick Reports and
plenty of other options to create the financial reports you need.

Advanced Tip: You can memorize settings and filters for special reports.
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The red line on the Rack marks the current day.

You can quickly see where "Today" starts on the Rack by noticing the red vertical line between the columns
for yesterday and today.

Note: The Rack shows yesterday as the first column, so you can see at a glance which reservations are due
to leave this morning and arrive today.

Advanced Tip: If you prefer not to see yesterday as the first column, you can change this through the Options
on the Rack -- but we recommend that you try it for awhile first, you'll probably like it!

Rack and Map indicator colors can be changed.

If you prefer a different color scheme, just change the colors through the Color Key.

Open the Color Key through the View menu (or right-click on the grid), then right-click on any color you want
to change.

To quickly see what sites are open, check "Available only" on the Rack.

This will remove any sites that are not available for the entire date range you select on the Rack.  You can
still see prior and future reservations to help you determine which site would be a good fit.

Advanced Tip:  When "Available only" is checked and you double-click on one of the open sites to make a
new reservation, it will use the dates from the Rack automatically for the new reservation.

Right-click is the way to speedy functionality.

You can click with the RIGHT mouse button on almost any part of the tab views to get a 'context-sensitive'
shortcut menu.  This menu contains the most common functions needed for the item you clicked on.

Advanced Tip: Some functions are ONLY available through the right-click menu.  For instance, Splitting a
reservation can only be done by right-clicking on a reservation in the Rack view.

Double-click is a shortcut for immediate action.

On many reports and tab views, double-clicking on the grid will perform a common function.  A couple
common examples:

- Double-click an empty cell on the Rack or the Map to make a reservation for that site and date.  (This also
works inside the New Reservation dialog.)

- Double-click an existing reservation to see Quick-info about it.

Experiment, you'll find lots of shortcuts using double-click!
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You can sort the way you want.

Click on the grid column header (the grey cells) in most report views to sort by that column.

It often does automatic secondary sorting as well.  For instance, if the Arrivals view is sorted by First Night, it
also sorts by the site number within each date group.

Advanced Tip: The sorting order is reversed if you click the same column header again.

You can turn these daily tips on and off through the Help menu..

Of course you would be missing out on a lot of cool tips if you turn them off now!

The "Reset/Today" button will reset the Rack or Map back to the starting point.

After changing dates, site types, etc. on the Rack or Map views, you can click the "Reset/Today" button to
reset everything to the beginning, with all sites shown.

Advanced Tip: If you don't normally need to see all sites, for instance if you have a storage area that rarely
needs to be shown, you can change the "Default" site filtering used.  See the site types drop-down list for the
"Default ..." setting.

Press the F9 key to quickly jump to a certain site or find a customer.

If you have a lot of sites, it can be tedious to scroll down the Rack to find a specific site.  Instead, press F9
(or use the "Search" icon on the toolbar, or Ctrl-S).  Type in the site number (or any part of the abbreviation)
and press Enter.  The Rack will automatically scroll to that site.

Advanced Tip: You can also use this on other views to search for sites.  It can also be used to search for
customers by entering a portion of their last name.

The F2 through F9 keys are shortcuts to the toolbar functions.

With the exception of F1, which is a standard for Help, each F-key across the top of your keyboard
corresponds to one of the toolbar functions.  For instance:

F2 = New Reservation
F3 = New Customer
F4 = New Transaction
etc...

The ESC key is a quick way to "dismiss" a dialog or message.

Most prompts and dialogs have a Cancel or Close button, which will close the dialog without making
changes.  The ESC key on the keyboard is a handy way to do the same thing as clicking Cancel or Close.

Advanced Tip: Ctrl-Enter will usually do the OK, Done, or Save function (to save any changes you've made).
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Yes / No / Cancel prompts have a default option.

Whenever you see a prompt that has buttons like Yes, No, and Cancel, look closely at the buttons.  One of
them will have a darker outline.  This is the default option (and usually the recommended or most common
response).  Read the prompt carefully before clicking one of the other buttons!

Advanced tip: Pressing the Enter key will select the default option automatically.

Any tab view can be printed.

Just click the "printer" icon on the toolbar, or press the F8 key, to print the current tab view report.

Advanced Tips: The Print Preview gives you a chance to make sure it will print the way you want.  See File /
Printing Options to adjust font size (zoom) and other options for reports.  See File / Printer Setup to select a
default printer, paper size and orientation for reports.

You don't have to print the entire Rack.

Check the "Show range" box on the Rack view to show only the dates selected.  This makes it easy to print a
schedule for the upcoming week.

Landscape orientation can be set as the default for printing reports.

If you prefer reports in landscape mode for a wider view, go to "File", "Printer Setup", "Default (grid-type
reports)" and select the Landscape orientation option.  Now all reports will assume landscape orientation.

Advanced Tip:  You can select a different paper size or even a separate printer for reports this way, for
instance to use a dedicated printer with legal-size paper.

'Tab' is the key to quick data entry.

When entering customer information, use the Tab key to jump to the next field.  Sometimes this also initiates
an automatic function like customer lookup, zip-code lookup, or auto-formatting phone numbers (depending
on the field you're coming from).

Advanced Tip:  To back up to the previous field, use Shift-Tab (hold the Shift key down while pressing the
Tab key).

You can use the Alt-key to press buttons without the mouse.

Whenever you see an underlined letter in a menu or in a dialog like this one, that's an 'Alt' hot-key.  Pressing
the underlined letter key while holding down the Alt key will select the indicated menu item, press the button,
or move the text entry cursor to the indicated field.

For instance, hold down the Alt key and press the 'N' key to go to the Next tip now.
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Shift-Click can be used to select multiple items in a list.

There are many functions which allow you to select multiple items (or rows) from a list, for instance when
printing customer mailing labels.  A quick way to select a whole block of items is to click on the first one you
want, locate the last one you want, and then hold the Shift key down when you click on it.  All of the rows
from the first one to the last one will be selected.

Advanced Tip:  Shift-click only works for a continuous block of items or rows (clicking again will clear any
previous selection).  If you need to select individual items that aren't all together on the list, use Ctrl-click on
each one.

Ctrl-Shift key combinations will activate functions on tab views.

For instance, Ctrl-Shift-T will reset the dates to Today, Ctrl-Shift-A will check (or uncheck) the 'Available only'
box, Ctrl-Shift-O for Options, etc.

The first letter of a checkbox or button name is usually the key to use.

Advanced Tip:  Use Ctrl-Shift with < and > for stepping the From date, and with - and + for stepping the To
date. (Use the - and + next to the Backspace key, not the ones on the numeric keypad.)

Dates can be selected using a pop-up calendar.

Whenever you see a date entry field, for instance at the top of the Rack, you'll notice a down-arrow next to it.
Click this arrow to open a calendar view, where you can select the date you want by simply clicking on it.

Advanced Tip: Click on the month or year at the top of the calendar to quickly change months or years.

Dates can be entered easily with the keyboard.

If you're more of a keyboard user, you can type in a date instead of selecting it from the calendar.  Once the
cursor is in the date field (the first number highlighted), just enter the date using slashes, like "3/17/04".

Advanced Tip: If you only need to change the day and not the month, start with the slash (/) key and just type
the date. For instance, to change 11/5/2004 to 11/9/2004, just type "/9" (assuming the "11" part of the date is
currently highlighted).

Date "steppers" save even more time.

If your screen resolution is at least 800x600, you'll see left and right arrows on each side of the dates in tab
views like the Rack.  These will adjust the date by one day with a single click.

Advanced Tip:  When one date is changed, the other one may be automatically adjusted to avoid backward
dates.  For instance if both dates show 8/15 and you want to see only 8/14, click the left-arrow for the TO
date.  The FROM date will also change automatically, saving you an extra click.
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You can start a reservation by entering customer details first.

If you prefer entering all of the customer information before selecting a site and entering reservation
information, then start with Customer / Add New Customer.  After entering the customer information, click the
"New Reservation" button to create the reservation.  This especially saves time when entering initial (old)
customers with reservations.

Advanced Tip: You can use the F3 key or the "customers" icon on the toolbar instead of Customers / Add a
New Customer from the menu.

The Rack can be used as a housekeeping or site-check report.

If you have to clean rooms after someone checks out (or perhaps verify that campers leave on time), you
need to know which ones will check out today.  Better yet, it helps to know which sites will also have
someone else check in today (back-to-backs), so you can prepare those first.

On the Rack, check "Show range".  Then change the dates to show yesterday and today, and you can clearly
see which sites have reservations ending and/or beginning today (note that back-to-backs will have a dark
double-line between them).  Press F8 to print the report.

Phone numbers are automatically formatted.

When entering a phone number (U.S. or Canadian), just enter the digits like 2135551212.  After you press
Tab to the next field, it will be formatted automatically to (213) 555-1212.

Note: This only works if you ONLY enter the digits, with no spaces, dashes, etc.  If any other characters are
entered, it won't re-format it.

When entering the Rig Length, just enter the number.

You don't need to enter the tick-mark for feet, as in 40' -- that will be added automatically if you just enter the
number 40 and press Tab to move to the next field.

Site choices can be narrowed down quickly by selecting a Site Type.

When looking for available sites or making a reservation, click on the list that shows "All Site Types" to
specify a particular type of site like Cabin or Pull-thru.

Advanced Tip: This can also be used to select a site Class, for instance if they'll take any type of RV site.

The Rack's date range is practically unlimited.

The Rack's normal scrolling range is kept small for better speed.  But if you need to see next year, just
change the "To" date to the last date you need to see.  Then you'll be able to scroll out to that date.  It works
the same way for past dates, of course.

Advanced Tip:  If the normal range is too confining, then you can change the default number of future and
past days available for scrolling.  This is set through the Options button on the Rack.
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Your data is more valuable than your computer -- MAKE BACKUPS!

Too often we hear the sad story of a computer's hard drive crashing, to find that their only backup was made
years ago.

We recommend using a rotation of 7 disks, labeled 'Sun' through 'Sat'.  Use one for each day of the week, so
you have 7 chances of a good backup if the worst happens.  (Better yet, use 2 sets that you can rotate off-
site in case of fire, etc.)

Advanced Tip: Use the Restore function after a Backup to make sure the floppy is a good one, since it won't
always report data errors when writing to it.

Map files are not included in the database backups.

Since your map images (BMP files) are not changed by the program, and because they can be large files,
they are not included in the regular backups.

Be sure you have adequate backups of these files, both on and off the premises.

Note: The site indicator positions you place on the map are saved in the database, and are thus included in
the backup.

Electric meter readings can be entered through the Meter Reading reports.

Once you have your meter rates set up and initial readings entered (through Site Details), your monthly
readings can be entered quickly through the meter reports.

Batch entry will automatically add appropriate charges to each reservation and update the site's reading, then
you can print all of the receipts at once.

Advanced Tip:  If you don't see the Sites or Occupants you expect in the report, check the settings at the top
of the report dialog.

'Owner' reservations help track occupancy and allow a site to be sub-leased.

Use the Owner reservation type to keep track of a site's owner or lessor information (billing, lease dates,
owner info, etc.).  Then you can make a Normal (or Free Stay) reservation on top of the Owner reservation to
keep track of when the owner plans to be there.  If they allow it to be sub-leased, you can make a reservation
for someone else on that site when the owner isn't occupying it.

Advanced Tip:  Set up a separate "Sub-lease" Reservation Type to make sub-lease income reporting easier
(see Maintenance / Pick Lists).

You can change the check-in and check-out times shown on receipts.

These are changed through Maintenance / Park Setup / Parks.

Advanced Tip:  Each park record can have separate times, so you can create multiple 'parks' if you have
different check-in or check-out times for some sites.
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You can change the notices that print on receipts.

See Maintenance / Park Setup to change the various bits of text on receipts, as well as some other options.

Advanced Tip: The "Additional Notes" section of the Ticket Form is a special case -- it's changed on the Park
record (Notes 1, 2, and 3), so you could have different notes for each park.

The default receipt type can be set through File / Printing Options.

If you find yourself having to select the receipt format every time you print a receipt, you probably need to
change the default.

You can select the default receipt format for reservation receipts, non-reservation receipts, and confirmation
letters.

Most drop-down selections (pick-lists) can be modified.

To set up your own preferred Site Types, Rig Types, Reservation Types, Transaction Categories, etc. go to
Maintenance / Pick Lists.

Note: Be careful about deleting list items that are already used by a previous reservation, etc.  It's OK to
move them around, though, with the Move Up and Move Down functions.  Pick lists should be set up early,
preferably before sites are set up, to minimize problems with deleting them.

You can change the order of the sites on the Rack.

To change the order of sites, for instance if you add more later that don't belong at the bottom, use
Maintenance / Park Setup / Sites.  The Move Up and Move Down functions will allow you move them around.

Advanced Tip:  You can move more than one at a time -- use Shift- or Ctrl-click to highlight multiple rows
before moving them.  It's easier to move 100 sites down one row than to move one site up 100 rows (with get
the same result).

Setting up a lot of numbered sites is easy.

If you have a lot of sites to set up that are identical except for the site number, go to Maintenance / Park
Setup / Sites and use the "Add/Insert Multiple Sites" function.

Hint: Add one of the sites first and set all of its attributes, then you can "clone" all of its settings to the other
sites with the Add/Insert Multiple Sites function.

You're not limited to just one map.

If your park is too large to fit on one map page, just break it up into multiple pages.  You can page through
them on the Map view using the Page Up and Page Down keys (or you can select any of the maps from the
drop-down list).

Advanced Tip: You can create an overview map with "hot spots" on it, so you can click on the area of interest
to switch to the detail map of that area.  Likewise, you can include clickable "buttons" on each map to switch
to another map.
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Check Rates is used to give rate quotes without making a reservation.

If you need to give someone a rate quote, you can do it from the New Reservations dialog.  You'll need to
first select a site (or sites) and the appropriate dates, plus any preferences, etc. they need (like the number of
adults).  Then click the Check Rates button to show the applicable rates.

Advanced Tip: It will auto-calculate the total if you've enabled Auto-Rates.

The Quote/Confirmation function lets you temporarily add charges.

In most cases, you don't want to actually add charges to a reservation until the customer checks in (so the
income doesn't show on reports until they pay).  However you may want to print a confirmation letter showing
any deposit made and what the charges will be.

Use the Quote/Confirmation function in Reservation Details to add the charges temporarily so you can print a
confirmation.  Once you close the Quote/Confirmation dialog, any charges added there will be deleted.

Confirmations can be E-mailed to your customers.

Campground Master can send mail through your Internet Service Provider's mail server.  See Maintenance /
Online Setup to set up the E-mail connection.

Once the E-mail setup is done, you'll see a new "E-mail Confirmation" button on the Quote/Confirmation
dialog.  Just click that button to create an E-mail message with the confirmation, which can be edited as
needed before sending.

Advanced Tip:  You can also send an E-mail to a customer through Customer Details -- just click on the blue
"E-mail" label next to their E-mail address.

The starting date for the Rack, Map, etc. can be advanced for next season.

If you're primarily taking reservations for next season (e.g. you're currently closed for the winter), see
Maintenance / Program Options / Reservations to set a default starting date.  This can really speed up
making reservations several months ahead of time.

The Find Customer function can search for nearly any customer data.

When you're looking for a customer with a particular phone number, license plate, first name or whatever,
use the Find Customer function (in the Customers menu).

Advanced Tip:  The searching is smart, depending on the field.  For instance, when looking for a license
number, all punctuation and capitalization is ignored.  So a search for 'txu' will find the license entered as TX
/ USD998.

The creation date, time, and operator name is recorded for each reservation.

To find out when a reservation was created, checked in, checked out or cancelled, go to Reservation Details
and click the "Activity History" button.
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Ctrl-R will re-open the last reservation you created or viewed.

When you realize you need to do something else with the last reservation you worked with, don't go hunting
for it again.  Just press Ctrl-R to open its Reservation Details.

The "Block-to" date for a reservation allows flexibility.

If you're not sure when someone will be leaving, use the Block date.  This blocks the site for that person, but
charges won't be added yet (e.g. if auto-rates are enabled).  It also serves as a reminder that the site might
be available later if they don't stay that long.

Advanced Tip: Blocked dates can be shown as "Available" on the Rack, depending on settings in Program
Options, so you can see what "might" be available.  However it won't allow making another reservation on
blocked dates.

The Rack can show the number of available sites, or percentage available.

You can enable this through the Options button on the Rack.  It can show a row with availability for a given
date, or it can show how many of a particular site type are available for the dates selected (as a pop-up tip in
the site type column).  This comes in handy if you need to book a large group and don't want to count rows
manually.

Note: If you have a large number of sites and/or reservations, this can slow down the Rack's refresh time
considerably.

The empty sites in the On Site tab view can be hidden.

The default settings for On Site tab are to include all sites in the report when it's sorted by site, to make it
suitable as a walk-around checklist.  If most of your sites are empty, you can disable this option (see the
Options button).

Advanced Tip:  Remember, you can also use the Search function (F9) to locate a site quickly.

Reservations don't have to be assigned to a site at first.

If you don't normally assign people to a specific site until they check in, then just don't select a site when
making a new reservation.  Then you can assign a site when they check in (or any time you like, perhaps
when they make a deposit).

Advanced Tip: You can turn off the warning message that normally appears when no site is selected, through
Program Options.

"No Site" is a special feature, not a cause for panic.

If you see a whole bunch of cells on the rack filled with "No Site:1", that simply means that there's a
reservation for that date (or dates) with no site assigned to it.  This will appear in every empty site for that
day, as a warning to leave a site open for the unassigned reservation.

To see the reservation(s) causing this, either right-click on it and select "View unassigned reservations" or
switch to the Unassigned tab view.  There's also an Unassigned report under the Reservations menu.
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It's easy to change the site for a reservation.

To change the site for a reservation (or to assign a site to an Unassigned reservation), just use the "Assign or
Change site" function.

This is available on the right-click menu in some tab views, and also in Reservation Details.  It will open a
dialog identical to New Reservation, where you'll simply select a site the same way as when you're making a
new reservation.

Swapping sites can be done from within the "Assign or Change Site" function.

If you need to swap two reservations, start with Assign or Change Site.  Once there, locate the reservation in
the grid that you want to swap with.  Right-click on that reservation and click the "Swap sites" function to
swap sites.

Note: This will swap sites for the ENTIRE length of the reservation, so it should only be done for future
reservations.  If a reservation is already checked in, you should Split it before swapping sites.

Reservations can be split on any date.

This is especially useful if you have to move someone in the middle of their stay.  On the Rack, right-click on
the reservation on the date where you need to split it (e.g. the date they move), and select "Split reservation
at this date".  Now it will be two separate reservations, and you can modify each half as needed -- including
site changes, date changes, or even customer changes.

Advanced Tip: You can elect to combine billing for both parts (e.g. a continuation on another site), or to keep
charges separate (e.g. if you're splitting just to start a new bill).

Ctrl-F is a shortcut to Find Reservation.

This is the same as the menu function Reservations / Find Reservation.

Note: The Find Reservation function also remembers the "Filter by" setting for your convenience.  While this
is usually helpful, be aware that another operator might change it.  This can result in confusion if you always
assume it's searching for Confirmation number, for instance, and they change it to search for Last Name.

Warning flags keep track of problem customers.

Set the Warning flag on Customer Details, and a special "danger" icon will appear whenever you bring up
that customer's information (like when making a new reservation for them).  This is handy for black-listing
customers, or it could be used to indicate that they have special needs or a back payment due -- use the
Notes field to indicate the reason for flagging them.

Advanced Tip: You can get a list of all flagged customers through the Customers menu.

Ctrl-U will open the Find Customer function.

This is the same as the menu function Customers / Find Customer.

Note: The Find Customer function also remembers the last "Filter by" setting you used, for instance "Last
Name" or "Phone Number", so you don't need to select it each time.
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Duplicate customers can be merged through Find Customer.

Occasionally a customer may get added twice, perhaps due to a spelling mistake.

To fix this, first use Find Customer (Ctrl-U) to locate the duplicates (they must both be showing in the list, so
enter just the first few letters of the name if necessary).  Then use Ctrl-click to select both of them, and click
the Merge Customers button.

A new window will show just those customers, with more detail.  Select the one to keep (whichever has more
accurate information), and click OK to merge them.  All reservations and transactions will be merged as well,
so you won't lose anything.

Blank rows on reports are date separators.

If you see a blank row in the Arrivals or Departures tab view, for instance, it's not an error.  Blanks are
inserted between each different date listed when a report is sorted by date, for easier reading.

The Payments Due tab view has a variety of options.

Using the settings available through the Options button, you can set up this report to show not only payments
due, but deposits pending for upcoming reservations.

Advanced Tip: Totals are shown at the bottom of the report.

The Transactions tab view reports can include sub-totals.

If you sort by a certain columns on the Transactions tab (in Details mode), it will insert sub-total rows for each
grouping.  For instance, sort by Pay Method to get sub-totals for each payment method.

Note:  You may see some negative totals, which indicate whether the transaction is a debit or a credit to the
books.

Advanced Tip: Check the Summary box after sorting to get an instant summary report grouped by that same
column.

A reservation's Paid-Through date determines its color on the Rack.

The reservation's text on the Rack (e.g the customer's name) will be in red for dates beyond the Paid-through
date.

Advanced Tip:  For other views, for instance on Departures, the text will be red if they haven't completely
paid through their last night.

Reservations and Customers are NOT the same.

It's important to understand that customer-specific information (name, address, etc.) is separate from
reservation-specific information (site, dates, etc.).  This allows a single customer to have many reservations
without duplication of data.  This also means that things like Find Customer and Find Reservation are
different, so remember to use the right tool for the right task.
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Customer Transactions are NOT Reservation Transactions.

If you add transactions to a Customer, those transactions will not be applied to reservations.  For instance,
don't put a reservation deposit in Customer transactions.

(A warning always appears if you attempt this -- don't ignore it!)

Reservations can be cancelled without losing the information.

When you use the "Cancel reservation" function, it only flags the reservation as Cancelled.  No information is
deleted, so you can retrieve it later using Find Reservation (and it's kept in the customer's reservation
history).

Advanced Tip:  You can view cancelled reservations by date range using the Non-Reserved tab view (select
"Cancelled" from the drop-down list at the top of that tab view).

Check-in, Check-out, Cancel, etc. can be un-done.

If you've mistakenly checked in a reservation, for instance, go to its Reservation Details.  Click on the
checked box in the Status area to un-check it, reversing the current status.

Advanced Tip: This is sometimes necessary to change the dates.  For instance to correct the First Night after
a reservation is checked in, you must un-do the Check-in status first.  After fixing the date, you can check it
back in.

Changing information in Customer Details is NOT the same as changing the customer for a
reservation.

Remember that customer data is separate from reservation data.  If you edit customer details, you're not just
affecting that one reservation -- you're changing the customer's master data record.  If you need to switch the
customer for a reservation, you must use the "Change to a different customer" function in Reservation
Details.

Advanced Tip: If it's a group reservation, this function is available on the right-click menu.

You can disable the Check-in and Check-out times for individual sites.

If you have some sites which don't have specific check in/out times, like storage units, then you can keep this
information from printing on receipts for those sites.

Go to Site Details for the site, and check "Don't show check in/out times on receipts" to hide the times.

You can track hourly reservations as well as daily ones.

By setting up Schedules with the Periods of interest (which don't have to strictly be hours), you can manage
rentals and reservations for equipment like canoes and bikes.  This could also be used for a hall that's rented
by the half day, golf cart rental, or whatever you need to track.

Advanced Tip:  These can also be added on to a customer's main reservation by linking them as "sub-
members", with combined billing.
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The Print Preview and Printer Setup dialogs can be skipped to speed up printing.

While previewing the receipt is handy at first, you'll quickly discover that it's an unnecessary step.  You can
turn off this and the Print Setup dialog step through File / Printing Options / Receipts.

Note: You can also turn it off for grid-type reports, but it's not recommended -- if you make a mistake in what
you're printing, the Print Preview can save a lot of paper!

Ctrl-T will re-open the last Transactions you worked with.

Need to print another receipt or add something else to a bill?  Just press Ctrl-T to open the last Transactions
you were working on.

Transactions can be modified at any time.

If you need to adjust part of a transaction (e.g. the description, category, quantity, or price), simply go to the
Transactions entry dialog and click on the grid to edit the desired field.

Note: There are restrictions to this depending on your operator access level.

Transactions can be back-dated for accurate record-keeping.

Transactions are normally recorded as of the date you enter them, regardless of the reservation date.

If you need to alter a date, for instance to enter previous payments, check the "Details" box on the
Transactions dialog.  This will show the transaction date field, which can be edited (with proper operator
access of course).

A reservation's Paid-Thru date can be changed on the Transaction dialog.

The Paid-Thru date won't be set automatically if a customer pays only part of the current charges, so it needs
to be adjusted manually.  This can be done through Reservation Details of course, but there's an easier way.

While you're still on the Transactions dialog, click in the paid-thru date cell for the reservation (in the upper
grid, showing the reservation information).  A small entry field will appear where you can change the Paid-
Thru date immediately.

The Transactions tab view can help you balance daily receipts.

The Transactions tab can show both summaries and details, so for instance if the Receipts quick-report
doesn't match your cash drawer you can simply un-check the "Summarize" box to instantly see all of the
details for each payment type.
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Use the "cash register" to enter anonymous counter sales.

Transactions don't have to be tied to a specific reservation or customer.  You can enter miscellaneous sales
using "Unbound transactions", which is normally accessed through the cash register icon on the toolbar.  (Or
through the Transactions menu.)

Advanced Tip: The optional Point of Sale module turns this into a full-function cash register with inventory
support, which speeds up store sales dramatically.

Credit card transactions can be processed through Campground Master.

With the appropriate add-on software and optional hardware, you can skip the multiple steps and duplicate
number entry required to process credit cards.  Campground Master will keep the records all in one place,
simplifying reconciliations.

Bonus: The credit card information is stored in the database for future use (encrypted for security), saving
time later too.

Memo transactions are useful for private notes about transactions.

On the Transactions dialog, click the "Memo" button to add comments about the customer's account -- the
reason for a charge or credit, when payment is expected, etc.

These Memos will be kept with the transactions, but they will NOT appear on receipts unless you check the
box "Show this Memo on the customer's receipt" when entering the memo.  (This box is always unchecked at
first, to avoid accidental printing of the memo.)

Notes can be added to customer receipts using Memo transactions.

If you want to insert a note into the transactions area of a customer's receipt, use the Memo function.  In the
Memo entry dialog, be sure to check the option to "Show this Memo on the customer's receipt".

You can enter as many memo lines as needed, but you should keep them short enough to fit on the receipt
without forcing the text to shrink.

Advanced Tip:  You can add "blank" memos to separate a note from the other transactions.  Try using all
capital letters for extra emphasis when needed.

Memo transactions can be changed between printable and non-printable.

If you meant to make a note printable but forgot to check the "Show this Memo..." box, you can fix it easily.

In the Transactions dialog, click on the Memo transaction's Category field (NOT the Type field -- that's
greyed out so it can't be edited directly).  The Category drop-down list will allow you to change it between
"Memo" (non-printable) and "Print Memo" as needed.
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Reservations for multiple sites can be linked together.

You can create multiple "synchronized" or "sub-member" reservations on different sites and/or different
dates, and they can be billed together or separately.  This is especially handy for groups.

To create linked reservations, just keep adding sites while you're in the New Reservation dialog.  You can
also add them later through Reservation Details, or through the right-click menu.

See the documentation for further details.

It can automatically select a number of sites to add for you.

To enable this function, go to Maintenance / Program Options / Reservations, and check the option to enable
automatic multiple-site selection.

Now a "Qty" entry field will appear on New Reservations.  Just select a Site Type and other preferences if
needed, enter a Qty, and click Add Selection(s).  It will automatically add any available sites up to the Qty
you entered.

Advanced Tip: To add them as non-synchronized instead of synchronized (so they're billed separately), enter
the Qty with a '#' in front, like "#20".

Guest reservations can be made on top of an existing reservation.

If you need to charge for guests visiting a resident, or at least want to keep track of them as separate
customers, use the Guest Management function in Reservation Details.  (Adding a Guest is also available on
the right-click menu.)

Advanced Tip:  The guest's reservation dates don't have to be the same as the host, but they do have to fall
within the host's stay.  (A guest can't stay longer than the host, for instance.)

The On Site tab view can show how many people are in the park.

Click on the Options button and make sure the Adults and Children fields are checked.  Now scroll to the
bottom of the report, and you'll see the totals for each column.

Advanced Tip: The totals row can be turned on and off through Maintenance / Program Options.

Find Customer can produce a listing of all customers with E-mail addresses.

Do you need to get a list of E-mails to send out notices?  Use Find Customer, select "E-mail" for the Filter-by,
and simply enter the '@' character.

Since any valid E-mail address has this character, you'll get a list of all E-mail addresses.

Advanced Tip: You can Export the list to a CSV file, or copy it directly into another program like Excel using
copy/paste (Ctrl-A to select all, then Ctrl-C).
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Copy and Paste work in many grid reports.

If you're familiar with Excel spread sheets, you know that copy/paste can be handy.

Campground Master supports copying from any grid-type report into Excel or other spread sheets using Ctrl-
C.

Advanced Tip: When editing Pick Lists or Raw Data Tables, you can also use copy and paste functions to
speed up entering duplicate data.

Most dialogs with report grids are sizable.

If you're using a screen resolution larger than 800x600, many report dialogs will seem small.  If you see a
"drag-thumb" in the lower-right corner of the dialog, just drag that with the mouse to enlarge it.  It will
remember the size for that dialog the next time you use it.

Some data fields can be renamed or removed.

Certain fields can be renamed for other purposes or removed altogether, to better suit your needs.

For instance, fields like "Adults" and "Children" can be renamed to "18 or over" and "Under 18", or even
"Members" and "Non-members".

See the documentation for more information.

Site Attributes and Reservation Preferences are customizable.

You can change attribute names to something more suitable for your business, and remove the ones you
don't need, using Data Field Definitions.

You should remove any that you don't need, to help reduce the database size and minimize the length of the
"More Preferences" list when making a new reservation.

See the documentation for details.

Mailing Labels and Envelopes can be printed for selected customers.

While the Reports / Envelopes function is great for a mass mailing, you can also use it to print small sets of
selected envelopes.

The Reservation Filtering can help narrow it down to start with, but you can also select individual customers
from the list to be printed.

Advanced Tip: Remember to use Ctrl-click to select multiple lines in reports like the mailing label customer
list.

Mailing lists can be exported to other programs.

If you prefer to use another program for mailings, for instance to mail-merge in a word processing
application, then you can use the Export List function to create a mailing list file from the Mailing Labels
report (or even from Find Customers, for instance).
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The Find Reservations function can be used to create a specialized report.

Lets say you need to get a list of reservations of a specific type, for certain dates, on certain sites.  Just open
Find Reservation (Ctrl-F) and use the Reservation Filtering to specify the reservations you need, then Print or
Export the list.

The Occupancy Report can show both past and future statistics.

Historical occupancy reports are nice for studying, but you can also use this report to show how many
reservations have already been made for future dates.

Advanced Tip:  You can use the Availability Report the same way, which is useful for making a printed quick-
reference to check availability.

Marking out-of-service sites helps avoid reservations on them.

Any site can be made "Unavailable" for specific dates using the "Special dates Unavailable" field in Site
Details.  These will show as dark grey on the Rack, and a warning will appear if you attempt to make a
reservation on an unavailable date.

Advanced Tip: To quickly mark dates as unavailable on individual sites, you can use the "Make site
unavailable" function on the right-click menu in the Rack.

You can easily view a site's entire reservation history.

On the Rack view, right-click on the site's header cell (the grey site number) and select "Find all reservations
for this site".  This shows all past, present and future reservations for that site.

Hint: Click the First Night header in the list to sort by date.

Advanced Tip: You can use Reservation Filtering to trim out cancelled reservations, etc. to narrow down the
list.

The Networking option allows you to connect through the Internet.

If you're licensed for networking and have a spare workstation (e.g. you're only using 2 of the 3 licensed
workstations), you can also access your data through the Internet when you're away from the office.  You'll be
able to see and work with the database in real time, just like in the office.

Advanced Tip:  Since a special IP port is used, you can make the connection secure by allowing access only
to that port through a firewall.

Credit for a future stay can be transferred to the Customer record.

When a customer wants to just keep a credit balance instead of getting a refund, use the "Transfer Payment"
function in the Transactions dialog to transfer the balance of a Reservation payment to the Customer's
transactions.  This will allow you to zero-balance the reservation and check it out or cancel it.

When the customer checks in with a future reservation, a reminder will show that they have a credit balance
which can be transferred back to the new reservation.
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Sites can be qualified by rig size by checking "Use Preferences".

If you enter a rig length when making a new reservation, and you have set the Rig Length attribute field for
your sites, then it will remove sites from the list that won't handle rigs of at least that length.

Note: This filtering is ONLY done if you have Use Preferences checked.

Advanced Tip: You can have it always check Use Preferences by default, through Maintenance / Program
Options / Reservations.

Access Levels can be used to limit functions for your own protection.

It's tempting to just make yourself an Administrator and always log in that way, especially if you're the only
user.  However, this means you could delete things or change critical information by accident.

We recommend that you normally use a Manager level log-in (or lower) to reduce the chance of mistakes.

Advanced Tip: The Access Level settings can also be used to disable some functions you never use.

You can skip the login prompt.

If you're the only user and the only person likely to have access to the computer, you might want to skip the
log-in step altogether, or at least skip typing the operator name and just type the password.

You can do this by adding /Operator and /Password parameters to the target field of Campground Master's
shortcut properties (e.g. for the icon on the desktop).

See the documentation for details.

The Toolbar can be turned off.

If you have all of the shortcut keys memorized, like F2 for New Reservation, etc., you can turn off the
Toolbar to get a couple more rows on the Rack.  This can be done from the View menu.

Advanced Tip:  You can also turn off the Status Bar, but it's not recommended.  If there's ever a problem
when starting up the program or with networking, the status bar may show useful information for determining
where it's having a problem (and if the problem is during startup, there won't be a way to turn it back on to
see the messages).

You can use Campground Master as a general ledger.

The "Enter an Expense" and "Enter Misc. Income" functions under the Transactions menu can be used for
accounting record-keeping, at least on a small-scale basis.

For reporting, you can use the Transactions tab view.  Filter by "Misc Income" and "Expense" transaction
types to see only those transactions, or use the "Income & Expense" Quick Report for an overall summary.

Advanced Tip:  You can add any expense and income transaction categories you need through Maintenance
/ Pick Lists.
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The Map view can be copied with Ctrl-C.

When you press Ctrl-C on the Map tab view, the current map (including site status) will be copied to the
clipboard.  You can paste it into any program that will accept an image -- E-mail, word processor, paint
program, etc.

Advanced Tip:  Put the map on your web site -- paste it into an image program, save it to a GIF or JPEG file,
and upload it to your web site to show availability for the selected date range.

Each networked workstation has some individual settings.

The view-specific and printer-specific settings are kept separate for each workstation.  For instance, you can
have each workstation configured to print different receipt formats, or to show different columns on the tab
views.

Advanced Tip: After initial setup, once you have all of the settings the way you like on the master, use the
"Synchronize local options" function to make all other workstation settings the same as the master.  This can
be done even if the others are not yet connected.

You can remove selected columns from grids before printing.

You can adjust the column sizes (e.g. shrink them to "nothing") right on grids like in the Find Reservation grid
before printing, and it will print accordingly.  To adjust column sizes, just grab the right-hand side of a column
header and pull it over (put the mouse over the column divider in the grey header row and you'll see the
cursor change to a double-arrow, then hold the mouse button down to drag it over).

The Reservation Receipts (Batch) Report can be used to print invoices for all reservations
that have a balance due.

- Click 'Filtering...', and click 'Reset All' to reset the filter.
- Uncheck the 'Include if no balance due' and 'Include if balance due < 0' options.
- Click OK.

Now you'll have a list of all reservations with balances due, and you can print an invoice (Receipt) for each
one.  The list can also be printed as a report.

Advanced Tip:  Use the Filtering options to exclude pending reservations, etc.

Campground Master remembers previous database file names and locations.

The last 20 database file names and locations used through File / "Open" or File / "Save As" are saved under
File / "Open Previous Database".  This can be useful for finding the correct database location if someone
accidentally saves it to the wrong location or makes a backup incorrectly.
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When Campground Master is updated, new tips may be added.

Whenever you install an upgrade, be sure to show tips on startup (see the Help menu to re-enable this later).

Besides getting a good refresher course, you'll be able to see any new and revised tips that may have been
added.

Note: New tips aren't always added to the end, so be sure to use the "Rewind to First Tip" button below to
reset them to the beginning.  Then watch for "New Tip!" or "New Feature!" in the upper right corner .
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